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第一章   版权说明 

 

本项目为免费和开源项目,本文档为付费文档，版权归贵州智慧开源软件有限公

司所有，并保留一切权利，本文档及其描述的内容受有关法律的版权保护，对本文

档和开源代码以任何形式的非法复制、泄露或散布到网络提供下载，都将导致相应

的法律责任。 

文档更新 

本文档由贵州智慧开源软件有限公司于 2021年 9月最后修订。 
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第二章   开发环境搭建 Eclipse 版 

注：支持 jdk1.8 及 jdk1.8 以上的所有版本，满足此条件的 java 开发环境都可

以集成我们的基础开发引擎，已经搭建好开发环境的可跳过本章。 

2.1  基础开发引擎项目的各软件版本 

JAVA运行环境：jdk1.8及以上 

SpringBoot：2.5.3 

EasyUI：1.4 

2.2  用 Eclipse+jdk1.8 搭建 Java 开发环境 

我们的项目支持所有的 java 开发环境，已经搭建好开发环境的忽略本节。其

它开发工具的搭建不再介绍，请自行查找相关资料。 

一、前期的准备 

1.jdk1.8 的下载 

(1)百度搜索 jdk，进入 jdk官网。 

(2)下载 jdk。 

http://www.zrpower.cn/
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(3)选中 Accept License Agreement,然后在 Winows x86（32 位系统的下这个） 

和 Windows x64（64 位系统的下这个）中选择 一个下载，如果不清楚自己的系统是 

32 位还是 64 位，可以百度，或者直接下载 32 位的 Windows x86。 

 

2. Eclipse 的下载 

(1)百度搜索 Eclipse，进入 Eclipse 官网。 

http://www.zrpower.cn/
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(2)选择方框里边的内容进行下载，这个必须和前面下载的 JDK 版本保持一

致， 前边下载的 32 位 JDK 这里就点击 32bit,前边下载的 64 位 JDK，这里就点

击 64bit。 

 

 

(3)继续点击方框中的内容，开始下载。 

http://www.zrpower.cn/


7 

    智慧开源基础开发引擎技术开发文档 网址：http://www.zrpower.cn 

 

 

 

二、JDK 的安装 

1.下载的 jdk 文件在这里，双击 jdk-8u66-windows-x64.exe 开始安装。 

 

 

http://www.zrpower.cn/
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2.平时我们安装软件不要安装在 C 盘，容易导致开机慢，改到 D 盘，点击

“更改”。 

 

把 C 盘改成 D 盘: 

http://www.zrpower.cn/
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下一步: 

 

开始安装 jdk... 

http://www.zrpower.cn/
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3.继续安装 jre，点击“更改”。 

 

找到刚才我们安装 JDK 的路径，D:\Program Files\Java,并在此目录下新建一

个文件夹 jre1.8.0_66，并选中。 

http://www.zrpower.cn/
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下一步: 

 

jre 安装中... 

http://www.zrpower.cn/
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4.安装完成，点击关闭。 

 

 

三、JDK 环境变量的配置 

1.找到自己 JDK 的安装目录， 复制其安装路径， 我的是 D:\Program 

Files\Java\jdk1.8.0_66。 

http://www.zrpower.cn/
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2.在计算机上右键--属性。 

 

 

3.按下图的顺序依次点击高级系统设置--环境变量--新建，在变量名中填写

JAVA_HOME,在变量值中填写第 2 步中复制的路径，并确定。 

http://www.zrpower.cn/
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4.再次点击新建，变量名填 CLASSPATH,变量值填下边这个，最好是直接复制我

的，每一个标点符号都要复制下去，并确定。 

.;%JAVA_HOME%\lib\dt.jar;%JAVA_HOME%\lib\tools.jar; 

 

5.在下方的系统变量中找到 Path，如方框 1 所示，选中填并点击编辑，在变量

值的最前边添加下面这一行（注意是添加，千万别把以前本来有的内容删掉了），也

http://www.zrpower.cn/
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是最好直接复制我的，每一个标点符号都要复制下去，添加完成后一直点确定直到

所有窗口关闭。 

%JAVA_HOME%\bin;%JAVA_HOME%\jre\bin; 

 

6.同时按住 Windows 图标键+R 键，弹出如下窗口，输入 cmd，并回车。 

 

 

7.依次输入 java -version 和 javac 并回车，如果出现一下信息则表明 JDK 

安装成功！阶段性的胜利！ 

http://www.zrpower.cn/
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四、Eclipse 的安装及配置 

 

1.解压开下载好的 Eclipse。 

2.进入到这个目录，并双击 eclipse.exe 启动 Eclipse。 

http://www.zrpower.cn/
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3.这里是要你选择工作区间，也就是你代码存放的地方，建议在 E 盘、F 盘等

位置新建一个文件夹（建议文件夹名称为英文或拼音）来单独存放代码，并选择左下

方的勾，并 OK。 

 

 

4.安装成功！ 

http://www.zrpower.cn/
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2.3  Eclipse 开发工具配置 jdk 

Eclipse开发工具是要编译并运行 java项目的，所以需要在 Eclipse开发工具上

配置 jdk环境。 

打开 Eclipse，单击“Window”菜单，选择下方的“Preferences”选项。 

http://www.zrpower.cn/
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点击 Java -> Installed JREs，在右侧点击 Add按钮，选择 Standard VM，点击

Next。 

 

 

http://www.zrpower.cn/
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JRE home 为当前 jdk 安装的路径，点击 Directory 选择当前 jdk 安装的路径

（D:\Program Files\Java\jdk1.8.0_66），JRE name 为当前 jdk 的一个名称，默认

jdk1.8.0_66，然后点击 Finish。 

说明：jdk 是带有编译和运行 java 的*.class 文件功能的，而 jre 只有运行 java

的*.class文件功能，所以建议选择 jdk。 

 

http://www.zrpower.cn/
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 最后点击 Apply and Close 即可完成 Eclipse开发工具中 jdk的配置。 

 

2.4  Eclipse 开发工具配置 tomcat 

我们的程序支持所有的 java 开发环境，已经搭建好开发环境的忽略本节。其

它开发工具的配置不再介绍，请自行查找相关资料。 

Eclipse 开发工具配置 tomcat，并且把项目部署到 Tomcat 服务器上。 

打开 Eclipse，单击“Window”菜单，选择下方的“Preferences”选项。 

 

http://www.zrpower.cn/
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单击“Server”选项，选择下方的“Runtime Environments”。 

点击“Add”添加 Tomcat。 

 

 

点击“Next”，选中自己安装的 Tomcat 路径。 

http://www.zrpower.cn/
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点击“Finish”完成。 
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建立一个 Web 应用，File → New → Dynamic Web Project 

 

 

创建一个 Dynamic Web Project 

http://www.zrpower.cn/
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点击“Next”下一步 
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点击“Next”下一步 

 

点击“Finish”完成 

 

让 Tomcat 服务器显示在控制台上，将  Web 应用部署到 Tomcat 中。

1.Window → Show View → Servers 

http://www.zrpower.cn/
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点击链接 No servers are available. Click ths link to create a new 

server.，在弹出的对话框中选择 Tomcat 版本。 

 

点击“Next”，添加我们的项目。 

http://www.zrpower.cn/
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选中项目并点击 Add，或是双击都可以添加到右边。 

点击“Finish”完成。 

 

返回下方的“Servers”面板，右键单击该面板中的“Tomcat v8.0 Server at 

http://www.zrpower.cn/
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localhost”节点，在弹出的快捷菜单中单击“Start”，即可启动指定的 Web 服

务器。如果此时直接启动访问 http://localhost:8080/TomcatTest ，会发现会

报 404 的错误。这是因为我们没有添加主页，下面添加主页(index.jsp) 的内

容： 

<%@page language="java" contentType="text/html; charset=utf-8" 

pageEncoding="utf-8"%> 

<!DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" 

"http://www.w3.org/TR/html4/loose.dtd"> 

<html> 

<head> 

<meta http-equiv="Content-Type" content="text/html; charset=ISO-8859-1"> 

<title>欢迎页面</title> 

</head> 

<body> 

欢迎使用 Eclipse 部署 Tomcat。 

</body> 

</html> 

 

注意：web 资源一定要在 WebRoot 目录下添加。如图： 

此时，再一次来访问该链接：http://localhost:8080/TomcatTest ，效果如

http://www.zrpower.cn/
http://www.w3.org/TR/html4/loose.dtd
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下： 
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第三章   框架配置及说明 

3.1  项目的软件架构图 

 

 

客户端（浏 

览器） 

 

Http 请 求 

url 

拦截器（进行请求参数 

验证和编码设置等） 

Controller 控制器（即请 

求路径的处理接口） 

Service 服务层 

DAO 接口层 

获取数据库连接 

解析 Mapper.xml  文
件 

并执行 SQl 操作 

Dbcp/C3p0/Druid 数据 

库连接池 

Mapper.xml 的 Sql 执行 

文件 

Oracle MySQL Sql Server 
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3.2  项目结构说明 

 

 

项目框架包含统计、流程、表单、查询等四大引擎及公共基础、数据库管理、

系统管理等 maven 模块目录，以及 web 静态资源。 

基于查询、流程、表单、统计四大引擎项目框架包含以下： 

 

src/main/java ： 包 含 了 controller 、 mapper 、 model\entiy 、

service\serviceImp 等控制、映射、模型\实体、接口等标准目录。 

src/main/resources：包含了 mapper、template、lib 等目录，分别存放

mybatis数据库映射文件 xml、静态文件、jar包等。 

src/test/java：maven模块下的测试代码。 

pom.xml：项目下的子模块（module）的 maven版本控制，相对独立。 

http://www.zrpower.cn/
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3.3  项目的核心技术说明 

1、项目的 Maven 配置，pom.xml 文件中，本项目采用 maven模块开发，用多

个 pom.xml文件，主要分为 maven project、maven module，主要解释如下： 

（1）主项目 maven 的 pom.xml： 

 

 

 

 

（2）入口 maven 的 pom.xml： 

http://www.zrpower.cn/
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（3）其它 maven 的 pom.xml： 

http://www.zrpower.cn/
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2、 项目中的 Java 反射工具类，用于解析 Map 和 JavaBean 之间的转换，

如图： 

 

 

3、 Mybatis 动态生成代码的配置，如图： 

 

http://www.zrpower.cn/
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4、 项目中的数据库连接池配置，如图： 

http://www.zrpower.cn/
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druid数据库连接池： 

 

 

c3p0 数据库连接池： 

http://www.zrpower.cn/
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dbcp数据库连接池： 

 

    

5、 项目中 Java 使用 dom4j 动态生成 mybatisConfig.xml 文件。 

6、 项目中 Java 动态生成 generator_java.bat 脚本文件及调用。 

 

3.4  Eclipse开发工具的 Maven配置 

在 C:\Users\Administrator\目录下创建.m2 文件夹，在.m2 文件夹下创建

settings.xml的文件，如图所示： 

http://www.zrpower.cn/
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在 settings.xml 的文件中配置本地 Maven 仓库地址及阿里云代理，文件内容如

下： 

 

具体代码如下： 

<settings xmlns="http://maven.apache.org/SETTINGS/1.0.0" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

          xsi:schemaLocation="http://maven.apache.org/SETTINGS/1.0.0 

http://maven.apache.org/xsd/settings-1.0.0.xsd"> 

 <!-- 指定Maven本地仓库的位置 --> 

    <localRepository>D:/repos</localRepository> 

    <!--  

    <localRepository>${user.home}/.m2/repository</localRepository> 

     --> 

    <interactiveMode>true</interactiveMode> 

    <usePluginRegistry>false</usePluginRegistry> 

    <offline>false</offline> 

     

    <mirrors> 

     <mirror> 

      <id>nexus-aliyun</id> 

   <mirrorOf>*</mirrorOf> 

   <name>Nexus aliyun</name> 

   <url>http://maven.aliyun.com/nexus/content/groups/public</url> 

     </mirror> 

    </mirrors> 

</settings> 

 

http://www.zrpower.cn/
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打开 Eclipse 开发工具，点击菜单 WindowPreferencesMavenUser 

Segttings，配置 User Settings（浏览找到 settings.xml文件），点击 Update Settings

按钮，如图所示： 

 

点击 Reindex 按钮，然后点击 Apply and Close 按钮即可 Eclipse 开发工具的

Maven配置。 

 

3.5  打包部署操作说明 

一、在本地上安装 Maven环境 

1.  Maven下载地址 http://maven.apache.org/download.cgi 

2.  将下载的文件（apache-maven-3.6.0-bin.zip）放在 D:\JavaPlatform目录

下并解压，如图 

 

 

http://www.zrpower.cn/
http://maven.apache.org/download.cgi
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3.  配置 Maven 环境： 

 

新增 M2_HOME环境变量 

 

 

新增 MAVEN_HOME 环境变量 

http://www.zrpower.cn/
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在 Path环境变量中新增 Maven配置，点击确定即可。%M2_HOME%\bin 

 

 

查看 maven是否安装成功，输入 mvn –version，出现上图说明安装配置完成。 

 

http://www.zrpower.cn/
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二、将 ZRSpringBoot 项目中本地引用的 jar包发布到本地 Maven 仓库 

说明：理论上可以在 ZRSpringBoot 的 pom.xml 文件中设置将本地引用 jar 包打

包到项目 jar 包 zrweb-0.0.1-SNAPSHOT.jar 中，但是实际上会有很多问题出现，不

建议使用。 

进入 ZRSpringBoot 项目所在的目录，如图 

 

将所有的本地引用 jar包发布到本地 Maven 仓库中去，命令如下： 

如将 xssProtect-0.1.jar发布到本地 Maven仓库中去，输入命令执行 

mvn install:install-file –Dfile=D:\JavaPlatform\TempJarLib\xssProtect-0.1.jar 

–DgroupId=com.zrpower –DartifactId=xssProtect –Dversion=0.1 –Dpackaging=jar 

 

 

命令参数说明： 

–Dfile为 jar 文件所在目录 

–Dgroup=com.zrpower 为 jar包的组 

–DartifactId=xssProtect 为 jar包的 ID 
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–Dversion=0.1 为 jar包的版本号 

–Dpackaging=jar 为发布类型为 jar 包 

 

 

 

至此，发布 jar 包到本地 Maven仓库成功，可以在本地 Maven 仓库中查看到发布

的 jar包，如下图： 
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其他 jar包的发布操作类似。 

另一种方式：使用 eclipse安装 jar包: 

使用 eclipse安装也有个前提，就是 eclipse 的 Maven要先配置好。不过我相信

使用 Maven的小伙伴的 eclipse的 Maven设置肯定是没问题的，不然还怎么用 Maven。 

具体操作： 

（1） File -->import -->Maven -->instal or deploy an artifact to a Maven 

repository 

  

 

（2）填写相关信息，如 Maven坐标，具体参考下图。完成后点击 Finish。 
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Group Id,Artifact Id,Version 的设置参考 pom.xml文件。 

（3）完成上述步骤后，就已经大功告成了，可以去本地仓库看下上面安装的东

西在不在。 

 

三、将 ZRSpringBoot 项目 pom.xml中所有本地引用的 jar包改为正常引用 

如图所示： 
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四、将 ZRSpringBoot 项目的数据库配置改为测试环境的配置参数 
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五、使用 clean package 命令将项目打成 jar包，如图： 

 

点击 Debug即可运行打包操作。 

 

六、将项目的 jar 包拷贝到服务器 D:\ZRpowerWeb的目录下，如图： 

 

   

七 、 cmd 进 入 到 D:\ZRpowerWeb 的 目 录 ， 执 行 命 令 ： java –jar 

zrweb-0.0.1-SNAPSHOT.jar，如图： 
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至此，项目在服务器上的部署完成。 

 

3.6  只集成引擎时说明 

不使用公司的系统管理部分，只使用其它引擎时集成说明(目的是对集成到项目

中的各种引擎赋 session 值，不然不能正常使用各种引擎)： 

引入 Session Bean: 

import zr.zrpower.entity.sys.SessionUser; 

 

Session 赋值的方法如下： 

SessionUser su = new SessionUser(); 

su.setUserID("0000000000000001");//用户 ID 

su.setLCODE("000000");//用户编号 

su.setName("张三");//用户名称 

su.setUnitID("001");//单位(部门)编号 

su.setUnitName("办公室");//单位(部门)名称 

su.setUserPageSize(28);//表格每页显示的记录数 
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su.setCustom1("");//自定义 1 

su.setCustom2("");//自定义 2 

su.setCustom3("");//自定义 3 

su.setCustom4("");//自定义 4 

su.setCustom5("");//自定义 5  

session.setAttribute("userinfo", su); 

基础数据同步。 

使用各种引擎需要将原开发框架中的一些数据同步到指定的表中。 数据表结构

请参照开发框架部分的表结构。 

需要同步的表包括： 

单位[部门]表(BPIP_UNIT) 

用户表(BPIP_USER) 角色表(BPIP_ROLE) 

用户角色表(BPIP_USER_ROLE) 

注：单位[部门]ID、用户 ID、角色 ID 规范请参照示例数据生成，单位 ID 是 12 

位、用户 ID 是 16 位(前 12 位为单位编号，后 4 位为流水号)，角色 ID 为数字类

型编号,不按编码规范生成引擎的有些功能不能正常使用。 

由于各种 ID 是按新的规范生成，所以需在集成项目的相关表中存放生成的编

号，以便更新数据。 

上面赋值 session 值时用的单位[部门]编号、用户 ID 要用新生成的编号赋值。 

 

3.7  创建数据表及演示数据 

通过[开发文档及数据库建表 sql／数据库建表语句及示例数据]下的 sql 语句建

表或插入演示数据，演示效果与公司网站 www.zrpower.cn 上的在线示例一样。 

提供三种数据库（oracle、mssql、mysql）的 sql语句，用户根据所使用的数据

库选用相关的 sql语句执行。 

 

3.8  Mysql数据库乱码处理 

如果软件执行保存到数据库中的中文出现乱码，按以下方法设置 mysql。 
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检查本地 mysql 安装文件目录下的 my.ini 配置文件，服务器和客户端的默认编

码方式设置成 utf8，设置的项目如下。 

character-set-server=utf8 

default-character-set=utf8 
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第四章   Web 组件调用说明 

 

电脑端前端技术用到 http://www.jeasyui.net/上的技术，详细文档请查看第三

方文档。 

手机端前端技术用到 http://amazeui.org/上的技术，详细文档请查看第三方文

档。1、 图标代码 

序号 代码 图标 所在位置 

1 icon-ftl-add   

2 icon-ftl-edit   

3 icon-ftl-info   

4 icon-ftl-cq   

5 icon-ftl-ty   

6 icon-ftl-fp   

7 icon-cancel   

8 icon-ok   

9 icon-filter   

10 icon-tip   

11 icon-remove   

12 icon-ftl-up   

13 icon-ftl-dw   

14 icon-save   

15 icon-reload   

16 icon-print   

17 userOruint   

18 icon-undo   
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2、 提示框 

序号 作用 代码 

1 
提 示 是 否 

confirm 

$.messager.confirm('My Title', 'Are you 

confirm this?', function(r){ 

if (r){ 

alert('confirmed: '+r); 

} 

}); 

2 Alert 

$.messager.alert('提示','内容'); 

$.messager.alert('提示','内容','error'); 

$.messager.alert('提示','内容','info'); 

$.messager.alert(提示','内容','question'); 

$.messager.alert('提示','内容','warning'); 

message("选择要操作的行数据!"); 

3 弹出框 

$('#win2').window({ 

width: 600, 

height: 400, 

top:(screen.availHeight-400)* 0.5, 

left:(screen.availWidth-600)* 0.5, 

  

modal: true, collapsible:false, href: 

mFileUrl, title: "上传图片" 

}); 

 

//关闭 

$('#win').window('close'); 

4 表格单双击 

//表格单击双击事件 

$(function(){ 

$('#data').datagrid({ 

// 单 击 事 件

onClickRow:function(rowIndex,rowData){ 

//alert("单击"); 

}, 

// 双 击 事 件

onDblClickRow:function(rowIndex,rowData){ 

//alert("双击"); 

} 

}); 

}); 
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5 
表格是否点

击选中 

var row = 

$('#datalist').datagrid('getSelected');//Boolean 

类型 

6 
局部刷新表

格 

$('#datalist').datagrid({ 

 

url:'../ActionJson.do?method=userlit&tabid='

+table+'&_t='+ new Date().getTime(), 

}); 

7 
树点击事件

监听 

$("#tremen").tree({ onClick:function(node){ 

table=node.id; getReload(); 

} 

}); 

8 
表格多选框

值获取 

var checkedItems = 

$('#datalist').datagrid('getChecked'); var names = 

[]; 

$.each(checkedItems, function(index, 

item){ names.push(item.code); 

}); 

var chestr=names.join(","); 

9 
表格工

具创建 

var toolbar = [{ 

text:' 新 增 ', iconCls:'icon-ftl-add', 

handler:function(){openAddWin();} 

},'-',{ 

text:' 编 辑 ', iconCls:'icon-ftl-edit', 

handler:function(){getRowId();} 

}]; 
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10 隐藏行 

$('#dg_list').datagrid({ rowStyler: 

function(index,row){//如果 

id=000001 时 ， 该 行 隐 藏  if 

(row.id==000001){ return 'display:none'; } } }); 

 

或者 

<table id="datalist" class="easyui-datagrid" 

 

data-options="toolbar:toolbar,pagination:tru

e,rownumbers: true,url: 

'',method:'get',border:false,singleSelect:true,f

it:true, 

rowStyler: function(index,row){ 

if (row.DD_ZJE < =0){ return 'display:none'; 

} 

}"> 

11 隐藏列表 
$('#dg_list').datagrid('hideColumn','parentI

D');//隐藏上级部  门编码 

  

3、 样式 

序号 作用 代码 

1 Text class="easyui-textbox" type="text" 

data-options="required:false" 

 

required:true,missingMessage:'必须填写配送

路线',editable:false 

2 Select class="easyui-combobox" editable:false 不

让输入 

3 Textear class="easyui-textbox" 

data-options="multiline:true" 

  style="height:60px" 

4 Data class="easyui-datebox" 

data-options="formatter:myformatter,parser

:myparser  " 
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5 Datatime class=" easyui-datetimebox" data-options=" 

formatter:myDateTimeformatter,parser:myDat

eTimepars er" 

6 Int class="easyui-numberbox" 

7 falot class="easyui-numberbox" 

data-options="required:false,precision:2" 

8 Data 日

期区间控制 

$('#dd').datebox().datebox('calendar').cal

endar({ 

validator: function(date){ var now = new 

Date(); var d1 = new 

Date(now.getFullYear(), now.getMonth(), 

now.getDate()); 

var d2 = new Date(now.getFullYear(), 

now.getMonth(), now.getDate()+10); 

return d1<=date && date<=d2; 

} 

}); 

 

4、 其他 

序号 作用 代码 

1 获 取 

ifranme 

$("#CollDataTable")[0].contentWindow.$("#C

L_ID").val() 

2 获取控件

值 

1、 text: $("input[name='"+name+"']").val(); 

2、 select：$('#SLEFT').combobox('getText') 

$('#SLEFT').combobox('getValue') 

3 设置控件

值 

1、 text：$("#"+name).textbox('setValue',n); 

2 、  select ：

$('#SLEFT').combobox('setValue',val); 

  

http://www.zrpower.cn/


57 

 智慧开源基础开发引擎技术开发文档 网址：http://www.zrpower.cn 

第五章   开发技术文档捐赠 

免费和开源项目，项目的可持续发展离不开您的支持，请作者喝杯咖啡吧。 

扫描下面的二维码捐赠 298 元，获取项目二次开发《智慧开源基础开发引擎（项

目开发技术手册）(SpringBoot+Mybatis+Thymeleaf+EasyUI+AmazeUI) V7.0 版本》(共

92页)。 

说明：捐赠后请将使用人姓名、工作单位、手机号、qq 号、邮箱、捐赠凭证截

图发到 672561350@qq.com,我们会在 24 小时内通过邮件发送最新完整的技术开发文

档。 

贵州智慧开源软件有限公司 

2021 年 9 月 

http://www.zrpower.cn/

